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Kit Overview (1/2) (feon

» XMC1200 Boot Kit

— Consists of an XMC1200 CPU Card

— Supported Application Card examples: Colour LED Card, White
LED Card

(Application Cards are orderable separately or as part of another Application Kit)

dﬁ Eﬁi !ﬁ

:
Eaer ¢

- RS RN
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Kit Overview (2/2)
» XMC1200 CPU Card

Micro USB 5 User LEDs

5V

- p2.2 00
p2.e 00
Pe.di4 ©0

PeA2 ©10
ra.ie (©©

On-board COM
and Segger
J-Link debugger

Connectors
Bonsi according to pin-out
SHD/ZSPD
SHCLK
(] TxD
‘ RxD

DEBUG & (COM

S0 8 +Rx 2.
SC+BTx O 3,
GNO

XMC1200 Edge connector for
Application cards

2015-05-22 Copyright © Infineon Technologies AG 2015. All rights reserved.
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Hardware Overview

» Connect XMC1200 CPU Card to PC via USB cable
» CPU Card is powered up (as indicatgd by LED on the card)

CPU Card powered
via USB cable

’ p2.4 OO p2y C‘] p2.2 @0 p23 . |
p2.6 '0'O p2i7 B2.86 ©1© p2.1 |
‘ p2.8 ‘OO palg Aeds ©© peas (@
I} - P21e QOO p2i1

uss ©0| oo

SHD/SPD wz =
SHCLK '*
7 TxD © m ulw = | {
‘S RxD P » < ||lp1.5 OO Bi4 Fe.8 |0 © pay

i - - P13 OO P12 Ussp ©:0 |uoop!
ikl el \ 21 lp11 OO pid do.c 00 paz (@

S0 8 +Rx X5 o wd
re.s O O pea pe.4 0O pas
SCelaTx O 2, . . . & pe.2 @0 n.c. nc. ©0 pa3 &

GNO uuu.infineon .COm/xmc

> Note: Supported Application Card m\ay be»additionally connected to

the CPU card
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Tooling Overview - (infineon
Boot Modes

» Boot Modes available

— UART Bootstrap-Loader Mode

— User Mode (Halt After Reset)

— User Mode (Debug) Default Mode of device on Boot Kit
— User Mode (Productive)

> Boot Modes can be configured via:

- DAVE™
— Download DAVE™

DAVE™ v4.1.2 download
- MemTool

— Download MemTool
MemTool v4.65.exe download

» For more information on how to configure the BMI value, please
refer to the XMC1000 Tooling Guide.

2015-05-22 Copyright © Infineon Technologies AG 2015. All rights reserved.
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Tooling Overview - infineon
DAVE™ (1/5)

» DAVE™ download package is available at:
http://infineon-community.com/LP=400

Registration for DAVE™

Please register to download DAVE™ version 4 and DAVE™ SDK version 4.

DAVE™ version 4 and DAVE SDK version 4 is now available as productive version
E 4.1.2 and DAVE™ SDK v4.1.2

The current versions are: DAV

After you will receive a email with a link to the download-page. With a click on the link you
can download a zip file that contains a setup.exe-file and a PDF-file with installation instructions.
Please check the JUNK or SPAM folder of your mail server if you don't receive a confirmation email

First Name* [ |

Last Name* | L

Email Address® [ ]

Country* [ Please select — v|

Company* [ ]

Business Phone | l

Target Application [—please select— v|

2015-05-22 Copyright © Infineon Technologies AG 2015. All rights reserved.
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Tooling Overview — infineon
DAVE™ (2/5)

i

» After registration, download and unzip the installer package

L DAVE-4.1.2_Installation

> Run DAVE-4.1.2-Setup.exe to install <. DAVE-41.2-Setup

DAVE™ IDE and SEGGER J-Link drivers [

Custom Setup

Select the program features you want installed.

- /| DAVE™4.1.2: IDE for compenent based programming with DAVE™ APPs

) O p e n DAV ETM Hll /|SEGGER J-Link w5.00h: -Link debug and USB drivers

DAVE™-SDK-4.1.2: SDK o develop DAVE™ APPs
.
TRV BT

DAVE Window
qt; - - Welcomne

» Update DAVE™ and DAVE™ libraries

- H e I p 9 C h eC k fo r U p d a tes i::’;::ir'mksm Ctrl Shift L

DAVE™ Forum
DAVE™ Mew:

- Help - Check for DAVE APP Updates

Cheat Sheets...

g2y Install DAVE APP/Example/Device Library...
[ Check for DAVE APP Updates |
Uninstall DAVE APP/Example/Device Library...
4+ Install New Software...
By Installation Details

W About DAVE™

DAVE™ v4 Library Store: DAVE™ APPs and other libraries; only if default Library store not installed yet



Tooling Overview - (infineon
DAVE™ (3/5)

» Install DAVE™ APPs libraries and Device Description
- Help - Install DAVE APP/Example/Device Library

Window

- Welcome ‘

() Help Contents
47 Search
Dynamic Help

Key Assist.., Ctrl+Shift+L
Tips and Tricks...

DAVE™ Forum

DAVE™ News

Send Feedback Mail

Cheat Sheets...

f2y  Install DAVE APP/Example/Device Library...
Check for DAVE APP Updates
Uninstall DAVE APP/Example/Device Library...
" Check for Updates
Lt Install New Software...
3 Installation Details

% About DAVE™

> Note: You may skip the above step if you are not using DAVE™
APPs

2015-05-22 Copyright © Infineon Technologies AG 2015. All rights reserved.



Tooling Overview -
DAVE™ (4/5)

E S

& Library Manager Wizard

Download Libraries Page
This wizard page helps in downloading the libraries of type example projects or apps library

Dave Site

Work with:| DAVE Apps Library Manager

Libraries
Enter the keywords to filter :

Name
.+ [] DEVICE_PACK
Library_DAVEDeviceDescriptions

DAVE APPs

<
Select All | | Deselect All

Description

Filters
Hide items that are already downloaded

Show only latest version

@

Find more library by working with the Library Update Sites

Cancel

N

- [] DEVICE_PACK
. [/] Library_DAVEDeviceDescriptions

- || DAVE APPs

Copyright © Infineon Technologies AG 2015. All rights reserved.
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Select DEVICE_PACK, Library_DAVEDeviceDescriptions
(XMC1200 Device) and DAVE APPs

(infineon.

Select DAVE Apps Library Manager in the drop-down menu



Tooling Overview -
DAVE™ (5/5)

» Accept terms of the license agreements and click Finish

i Library Manager Wizard

License Review Page

V]| IFX_APP_LIBRARY

This wizard page helps to review the license of a selected library before download

IMPORTANT DOWNLOAD NOTICE -
The software you have requested for download is
protected by national and international copyright
laws and may be protected by other intellectual
property rights.

You shall use the software only in accordance with
the applicable licensing terms and conditions which
may be different from the terms and conditions of
the DAVE Software License Agreement, For copyright
infarmation, licensing terms and additional
information (e.g. on how to obtain the source code
of such Open Source Software), please check the
“Help Function”, Section "Copyright and Licensing
Information” of the software.

By downloading the software, you acknowledge that
you have read and understood this download notice.

@ Taccept the terms of the license agreements

Tdo not accept the terms of the license agreements

< Back lext > Cancel

> DAVE™ APPs libraries and Device Description are installed

2015-05-22
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Gett|ng Started - Example - iﬁneon
Blinky based on XMC Lib (1/6)

1. Open DAVE™ @& 3. Select the device accordingly
W . [ New DAVE Project = /|
2. Create a new "Simple Main ieoconuoterSlation e —

p rOJ e Ct ' Select the microcontroller for which the project has to be created
L]

> [] XMC1100 Series -

- File > New ->DAVE Project g e dm—

[[] ¥MC1202-Q040:0032
[ ¥MC1202-Q040:0016

— Enter prOjeCt name €e.g. 7] XMC1202-TO2840064

. [7] XMC1202-T028x0032

" X M C 1 2 O O B I N ky " [7] XMC1202-T028x0016
- [[] AMC1202-Q024:0032

[ ¥MC1202-Q024:0016
[ ¥MC1202-T016:0032

— Select "Simple Main Project” as e Torgenns -

Microcontroller Features

Project Type

ROM= 200 KB Flash

m

nmi »

\ RAM= 16 KB RAM

& MNew DAVE Project S InOut= 34 digital /0
DAVE Project ADC= 12 ADC Channels, 12-bit, Analog-to-Digital Converter -

Create s new C/C+= project for Infineon tool chains

Linker Option
ProjectName:  XMC1200_Blinky _ Remove unused sections
Use default location Runtime Library
C:/Workspaces/DAVE-4.1/WS_2015_07_23 Browse Library Newlib-nano -
Project Type: Tool Chain: [] Add floating peint support for printf
4 (= Infineon Projects _ [] Add floating point support for scanf

4 & ARM-GCC Application
[Z] Easy Start Project
Simple Main Project
DAVE CE Project
= Empty Project
4 & ARM-GCC Library
[Z] Empty Project

Xt > Finish ] I Cancel

m

Show project types and taol chains only if they are supported on the platform

2015-05-22 Copyright © Infineon Technologies AG 2015. All rights reserved.



Getting Started — Example - infineon
Blinky based on XMC Lib (2/6) (e

» For this project, we will use

— System clock frequency of 8MHz
— LED on Port pin 0.0
- System timer, SysTick, as the time base for interrupt

» Next, we will show you how to

1. Set up the System or Main Clock (MCLK)
2. Configure Port pin
3. Configure SysTick and define its exception service routine



Getting Started — Example - infineon
Blinky based on XMC Lib (3/6) (e

1. Set up System or Main Clock (MCLK) using XMCLib
- Include the header files required for MCLK and GPIO configuration

#include "xmc_gpio.h
#include "xmc_scu.h"

- MCLK configured via IDIV and FDIV bit fields in
XMC_SCU_CLOCK_CONFIG data structure

XMC_SCU_CLOCK_CONFIG t clock config =

{
.pclk_src = XMC_SCU CLOCK PCLKSRC _DOUBLE MCLK, /*PCLK = 2*NMCLK*/
.rtc_src = XMC_SCU CLOCK RTCCLKSRC DCO2,
fdiv = 9, [/**< Fractional divider */
Lidiv = 4,  /FFMCLK = 8MHz */
¥

— Initializes clock generators and clock tree in Main.c

int main(void)

{

/* Ensure clock frequency is set at 8MHz (MCLK) */
XMC_SCU _CLOCK Init(&clock config);

2015-05-22 Copyright © Infineon Technologies AG 2015. All rights reserved.



Getting Started — Example - infineon
Blinky based on XMC Lib (4/6) (e

2. Configure Port pin

— GPIO to toggle the LED is configured via mode and output_level
of XMC_GPIOC_CONFIG structure.

XMC_GPIO CONFIG t gpio_output config =
{

.mode
.output level

}s

XMC_GPIO MODE_OUTPUT PUSH PULL,
XMC_GPIO OUTPUT LEVEL HIGH,

— Initializes port pin P0O.0 as general purpose output pin in Main.c

/* Initialise P@.@ as an output pin */
XMC_GPIO_Init(LED1, &gpio_output_config);

2015-05-22 Copyright © Infineon Technologies AG 2015. All rights reserved.



Getting Started — Example - infineon
Blinky based on XMC Lib (5/6) (e

3. Configure SysTick and define its exception service routine
- SysTlck exception handler is defined in startup_ XMC1200 S

__________________________________________________________________________

.globl SysTick Veneer
SysTick_Veneer:
LDR R®, =SysTick Handler
MOV PC,R@

__________________________________________________________________________

— Initialize the SysTick in Main.c

B

/* System timer configuration
SysTick Config(SystemCoreClock / TICKS PER_SECOND);

— Define the SysTick exception handler routine in Main.c
void SysTick_Handler(void)

{
static uint32 t ticks = @;

ticks++;
if (ticks == TICKS_WAIT)
{
XMC_GPIO ToggleOutput(LED1);
ticks = 8;
¥
}

2015-05-22 Copyright © Infineon Technologies AG 2015. All rights reserved.



Gett|ng Started - Example - iﬁneon
Blinky based on XMC Lib (6/6) (fheon

» Build project

1 C||Ck ;.‘ 'Invoking: ARM-GCC Print Size'

C:\DAVEVA\DAVE-4.1.2\eclipse\ARM-GCC-49/bin/arm-none-eabi-
text data bss dec hex filename

2. Wait for Build to finish 2232 20 1040 3292 cdc XMC1208 Blinky.elf

"Finished building: XMC1208@ Blinky.siz'

» Download code

1. Click 3z
2. Switch to Debug perspective  oavee  davece 4 Pinapping
3. Click & to run code

Pl J.Qun0 PB.1@ OO PB.11

PR2 Foup v
PBS Foy v
P86 oy s —

» LED blinks every 0.2s Bi-= e
Ul xHC 5 @

1200

T

2015-05-22 Copyright © Infineon Technologies AG 2015. All rights reserved.



Gett|ng Started - Example - iﬁneon
Blinky based on DAVE™ APPs (1/7)

1. Open DAVE™ @& 3. Select the device accordingly
2. Create a new "DAVE CE” '.;.,cm —

p rOJ e Ct ' Select the microcontroller for which the project has to be created
L]

. . > [C] XMC1100 Ser?es -
- FI | e eN eW eDAVE P rOJ ect ‘ iﬁg?_;geg”frsgggxozgg _
[] XMC1202-Q040:40032
[ ¥MC1202-Q040:0016

— Enter project name e.qg. o iz ason
“ : : " XMCL02- 10280016
XMC1200_Blinky_withApps é‘“ﬂ
KMC1202- Q0240016
|:| HMC1202-T016:0032

- Select “DAVE CE PrOJeCt" as 71 ¥MC1207-TO &1 6 &

Microcontroller Features

Project Type o 5070

m

nmi »

RAM= 16 KB RAM
& MNew DAVE Project [E=EER == InOut= 34 digital /0
DAVE Project ADC= 12 ADC Channels, 12-bit, Analog-to-Digital Converter -
Creste a new C/C++ project for Infineon tool chains
Linker Option

Project Mame:  XMC1200_Blinky_withApps _ Remove unused sections

Use default location Runtime Library

C:/Workspaces/DAVE-4.1/WS_2015 0723 Browse ) -
Library Mewlib-nano -
Project Type: Tool Chain: [] Add floating peint support for printf
4 (= Infineon Projects . .
[] Add floating point support for scanf

4 (5 ARM-GCC Application
[Z4] Easy Start Project

imple Main Project
[] DAVE CE Project
[2] Empty Project

4 (5 ARM-GCC Library
[Z] Empty Project

m

Xt > Finish ] I Cancel

Show project types and tool chains only if they are supperted on the platform

2015-05-22 Copyright © Infineon Technologies AG 2015. All rights reserved.



Getting Started — Example - (infineon
Blinky based on DAVE™ APPs (2/7)

» For this project, we will use

— System clock frequency of S8MHz
— LED on Port pin 0.0

— System timer as the time base for interrupt
— Time base of 0.2s

» Next, we will show you how to

1. Set up the System or Main Clock (MCLK)
2. Configure Port pin

3. Configure System Timer and define its exception service
routine



Getting Started — Example -
Blinky based on DAVE™ APPs (3/7)

1. Set up System or Main Clock (MCLK)

— Click *: to add new APP

— Double-click CLOCK_XMC1 APP and
close window

— Open APP configuration editor

— In APP Dependency view, double-click
CLOCK_XMC1

am APP Dependency i3 | g g HW Signal Connectivity

CLOCK_XMC1

CLOCK_XMC1_0

— Configure APP instance

— In APP configuration window, set Main
clock (MCLK) to 8MHz

(infineon.

& Add New APP =T |

Show hidden categories Search filter

4 [= System

es ANALOG IO [4.04]

e CLOCK XMC1 [4.06]

aa CMSIS_DSP [4.0.2]

s CMSIS_RTOS RTX [4.0.2]
es CPU_CTRL_XMCL[4.0.2]
ww DIGITAL IO [4.0.6]

o EVENT_DETECTOR [4.0.2]

BB

Double-Click on the APP to add it to the active project.

V| Show latest versions only

#|Hide beta versions

8 MHz
EVENT_GENERATOR / —— MCLK wu
ACMP APP
PERIPH
32768 | kHZ
— RTC_CLOCK—,. H'
32.768 kHZ
WDT_CLOCK—-. i.
32.768 LG ¥

2015-05-22 Copyright © Infineon Technologies AG 2015. All rights reserved.



Getting Started — Example - (infineon
Blinky based on DAVE™ APPs (4/7)

2. Configure Port pin -

. + Show hidden categories | Search filter
- Click ™ to add new APP _ —
. o _is.::ALOG_Io [4.04] Ii/

— Double-click DIGITAL_IO APP and B v psp ozl :

close window i o oot 03

wm EVENT_DETECTOR [4.0.2] b am APP Dependency 3 | o
— Open APP Conflg u ratlon ed Itor eo::l‘e-cll'frkon theAPP.‘Dlada’(Ho.‘be active profect. TRl
, S DIGITAL_10_0
— In APP Dependency view, double-

click DIGITAL_IO

_ _ — Assign pin to P0O.0
— Configure APP instance

- Click # to open Manual Pin
— In APP configuration window, set Pin Allocator

direction to Input/Output and set :
Initial output level to High B ‘(C"sng; Number (Port) to #17

- Solve and Save

DIGITAL IO 0 53

General Settings

Manual Pin Allocat s
Pin direction: |Input/Qutput - e
Filter ALL -
Input Settings
Tristate - oE
- APP Instance Mame APP Pin Name Pin Mumber (Port)
Standard  DIGTALIOS
pin #17 (P0.0)
Output Settings
Mode: Push Pull -
& 5 [ Reset |[ @
Initial output level: | High -

2015-05-22 Copyright © Infineon Technologies AG 2015. All rights reserved.



Getting Started — Example -
Blinky based on DAVE™ APPs (5/7)

3. Configure System Timer and define its
exception service routine

— Click 1 to add new APP
— Double-click SYSTIMER APP and close window
— Open APP configuration editor

— In APP Dependency view, double-click SYSTIMER

— Configure APP instance

- In APP configuration window, under General
Settings tab, set System timer tick interval to
100000us (0.1s)

SYSTIMER_O 2

General Settings | Interrupt Settings

SysTick tirner pericd [us]: 100000

Mumber of software timers: 1

2015-05-22 Copyright © Infineon Technologies AG 2015. All rights reserved.

& Add New APP

Show hidden categories

4 = System
v ANALOG_IO [4.04]
s CLOCK_XMCL [40.5]
ua CMSIS_DSP [4.0.2]
wa CMSIS_RTOS_RTX[4.0.2]
es CPU_CTRL_XMC1 [4.0.2]
wu DIGITAL IO [4.0.6]
a EVENT_DETECTOR [4.0.2]
a EVENT_GENERATOR [4.1.8]
aa [INTERRUPT [4.0.4]
s RTC[414]
aa SYSTIMER [41.6]

"STIMER
SYSTIMER_O

DIGITAL_IO

DIGITAL_IO_O

(infineon.

CTRL_XMCA1

CPU_CTRL_XP.1C1_E|

CLOCK.) T
CLOCK_XMC1_0

ow APP Dependency 52 | o HW Signal Connectivity £l



Getting Started — Example - (infineon
Blinky based on DAVE™ APPs (6/7)

— Create software timer using SYSTIMER Apps.

TimerId = (uint32 t)SYSTIMER CreateTimer(Point2SEC,SYSTIMER MODE PERIODIC, (void*)LED Toggle EveryPoint2Sec,NULL);
if (TimerId != 8U)

{

//timer is created successfully, now start/run software timer

status = SYSTIMER StartTimer(TimerId);
¥

— Define exception handler routine in Main.c

— Define the toggle interval (in usec)

#define Point2SEC 200000U

void LED_Toggle_EveryPoint2Sec(void)

{
DIGITAL_IO_ToggleOutput(&DIGITAL_I0_B); //to
}

4%

ggles : 1 -> @ (if initial output level is logic 1

2015-05-22 Copyright © Infineon Technologies AG 2015. All rights reserved.



Gett|ng Started - Example - (iﬁneon
Blinky based on DAVE™ APPs (7/7)

» Generate code

1. Click [#
"Invoking: ARM-GCC Print Size'
y  Build project "C:\DAVEVA\DAVE-4.1.2\eclipse\ARM-GCC-49/bin/arm-none-eabi-size" -
text data bss dec hex filename
1. Click ;.A 3936 20 1096 5052 13bc XMC1200 Blinky withApps.elf

"Finished building: XMC1200 Blinky withApps.siz'

2. Wait for Build to finish

» Download code

1. Click %

2. Switch to Debug perspective DR DR DR
3. Click U™ to run code o g!sS OO UBD  Pet6 OO PoAl

M=

Nl o

> LED blinks every 0.2s . e

2015-05-22 Copyright © Infineon Technologies AG 2015. All rights reserved.



General Information (1/2)

» Where to buy Kkit:

— http://ehitex.com/starter-kits/for-xmc1000

— Order Number: KIT_XMC12 BOOT _001

> Infineon parts utilized on kit:

Infineon Parts
XMC1200 Microcontroller
XMC4200 Microcontroller
3V3 regulator

Order Number
XMC1200-T038F0200
XMC4200-Q48F256
IFX25001MEV33

(infineon.


http://ehitex.com/starter-kits/for-xmc1000
http://ehitex.com/starter-kits/for-xmc1000
http://ehitex.com/starter-kits/for-xmc1000
http://ehitex.com/starter-kits/for-xmc1000
http://ehitex.com/starter-kits/for-xmc1000
http://ehitex.com/starter-kits/for-xmc1000

(infineon

General Information (2/2)

»  Kit documentation:
- Boot Kit XMC1200

— Video Series: XMC1000 Boot Kit Getting Started
— Introduction
- DAVE™ Setup
— Boot Mode Index Configuration via DAVE or MemTool
- XMC1200 Hardware Setup
— Simple Blinky Example

- Blinky Example based on DAVE™ Apps

- Example Projects Download

2015-05-22 Copyright © Infineon Technologies AG 2015. All rights reserved.
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http://3559.2871.m.edge-cdn.net/vsc_2871_3559_1_vid_510857/XMC1000-Boot-Kit-Getting-Started-Boot-Mode-Index-Configuration-via-DAVE-or-MemTool.html
http://3559.2871.m.edge-cdn.net/vsc_2871_3559_1_vid_511113/XMC1000-Boot-Kit-Getting-Started-XMC1200-Hardware-Setup.html
http://3559.2871.m.edge-cdn.net/vsc_2871_3559_1_vid_511113/XMC1000-Boot-Kit-Getting-Started-XMC1200-Hardware-Setup.html
http://3559.2871.m.edge-cdn.net/vsc_2871_3559_1_vid_511100/XMC1000-Boot-Kit-Getting-Started-Simple-Blinky-Example.html
http://3559.2871.m.edge-cdn.net/vsc_2871_3559_1_vid_511100/XMC1000-Boot-Kit-Getting-Started-Simple-Blinky-Example.html
http://3559.2871.m.edge-cdn.net/vsc_2871_3559_1_vid_511100/XMC1000-Boot-Kit-Getting-Started-Simple-Blinky-Example.html
http://3559.2871.m.edge-cdn.net/vsc_2871_3559_1_vid_511100/XMC1000-Boot-Kit-Getting-Started-Simple-Blinky-Example.html
http://3559.2871.m.edge-cdn.net/vsc_2871_3559_1_vid_511087/XMC1000-Boot-Kit-Getting-Started-Blinky-Example-based-on-DAVE-Apps.html
http://3559.2871.m.edge-cdn.net/vsc_2871_3559_1_vid_511107/XMC1000-Boot-Kit-Getting-Started-Example-Projects-Download.html
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Where to find XMC Lib documentation?

1. Go to DAVE™ Version 4 website

http://www.infineon.com/dave/v4

Infineon 5,

infineon

4. Click on Modules or Files

XMC Peripheral Library for XMC1000 Family

Related Pages | Modules | Files

XMC Peripheral Library

——

2. Download XMC Lib and unzip file

XMC™ Lib Resady to use APIs for peripherals which are tested for GNU-, ARM-, [AR- und TASKING- compiler,
and released for Altium, ARMKEIL, Atollic, |AR Systems und Rowley compiler IDEs.
Low level driver libraries for XMC™ peripherals (APIs), CMSIS [ MISRA 2004 compliant including

documentafion. XMC™ Lib — Release Mote

Table of Contents

4 Supported devices and toolchains

System: Timer/PWM: Analog- Communication: Application Examples:
mixed specific: L
Signal:
u DMA u CCU4 u ACMP u CAN = BCCU m Examples
= ERU = CCUS = ADC = 2C = LEDTS for all
n FCE = HRPW m DAC = SPI m MATH periperhals
m FLASH = POSIF = DSD = UART m POSIF drivers and
u GPIO = USBE = HRPWM ARM,
u MATH » USIC GOC. AR, The XMC Peripheral Library (XMC Lib) consists of low-level drivers for the XMC product family penpherals
Built on top the Cortex Microcontroller Software Interface Standard (CMSIS) and MISRA-C 2004 compliant, it provides access to all peripheral features.
m PAL = Ethernet and
u PRMNG Tasking

Modules

Here Is a list of all modules:

3. Open XMC1_Peripheral_Library

. CMSIS

Analog Comparator(ACMP) low level driver for XIMC family of microcontroflers.

Bccu Brghtness and Color Control Unit (BCCU) dnver for the XMC1 microcontrolier family
HMClib ccus Capture Compare Unit 4 (CCU4) low level driver for XMC family of microcontrobiers
d ccus Caplure Compare Unit & (CCUS) low level driver for XMC family of microcontrosers
. ERU Event Request Unit (ERU) dnver for the XMC microcontrolier family
License FLASH Fiash onver for XIC mcroconirolle amiy
— GPIO General Purpose Input Output (GPIO) driver for the XMC microcontrolier family
12c Inter Integrated Circui(IC) dnver for the XMC microcontrolier family
Readme LEDTS LED and Touch-Sense control(LEDTS) driver for the XMC controlier family
f— MATH MATH Coprocessor (MATH) driver for the XMC1302 microcontroller family
R . PAU Peripheral Access Unit (PAU) driver for the XMC1000 microcontrofier family
|£§E] KMC1_Peripheral_Library POSIE Posion nferface Unt (POSIF) cnver for the XIC mirocontralerfamiy
PRNG Pseudo Random Number Generator (PRNG) dniver for XMC 1000 mecrocontroller family

RTC driver for XMC microcontroller famay
System Control Unit(SCU) driver for XMC microcontrolier family

[ XMC4_Peripheral_Library i

Pl nchronous serial channel driver for SPI-like communication
UART Universal Asynchronous Recenver/Transmitter (UART) driver for XIMC microconiroles family
usic Universal Senial Interface Channe}(USIC) driver for serial communication

VvADC Versatile Analog to Digital Converter (VADC) driver for XMC microcontroller tamily

woT Watchdog driver for the XMC microcontrolier family
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File List

Here is a list of all documented fies with brief descripiions:

2 xme1_flash.h
2 xme1_gpioh
2 xme1_rich
2 xme1_seuh
2 xme_acmp.h
2 xme_becuh
2 xme_ccudn
2 xme_ccus.h
2 xme_erun
2 xme_flash.h
2 xme_gpio.n
2 xme_izen
2 xme_ledts.n
2 xme_math.h
2 xme_pau.h

& xme_pesith


http://www.infineon.com/dave/v4
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infineon

Where to find DAVE™ APP documentation?

1. In DAVE™, go to Help = Help Contents

Welcome

(Z) Help Contents

4 Search

Dynamic Help

2. Expand DAVE Apps - Click on CLOCK_XMC1 - Overview

4 Help - DAVE™

Search: Scope: All topics
Contents (SR » = g

= @ Waorkbench User Guide

# Y Java development user guide

@ Plug-in Development Environment Guide
[+ @ C/C++ Development User Guide

B2~ DAVE APPs

+ € DAVE™ User Manual

* EGit Documentation

= Xtend User Guide

@ Xtext Documentation

2015-05-22

& clock xmet

=| B (s

i 5 o @ oa & B
Hide: Locate  Back Stop  Refresh  Home Fort Prirt  Options
Conterts | index | Search | Favortes |

e | CLOCK_XMC1
& @ Apes

@ License Tems and Copyright Infom|
@ Abbreviations and Defintions
= () Overview
[E] Overview
@ Avchiecture Description
& @ APP Corfiguration Parameters
Enumerations
Data stuctures
Methods
Usage
Release History

Home |

Overview

Overview
The CLOCK_XMC1 APP provides the following functionalities:

1. Setting the sources of various clocks in XMC1 devices

2. Configuration of Main clock,

3. Selection of fast peripheral clock.

4. Selection of RTC source
Main dlock is calculated using following formula
MCLK = dco_clk / (2*(IDIV + FDIV/256)) for IDIV>0,
Here dco_dclk is 64MHz and MCLK is required frequency.
where IDIV is 8-bit integer divider and FDIV is fractional divider.

Note:

By default, the SystemInit() calls weak API SystemCoreClockSetup() which exits in system_XMC1x.c file. When the
CLOCK_XMC1 APP used in the project, then SystemInit() calls the SystemCoreClockSetup() which exists in clock_xmc1_conf.c
file

This APP do not provides data structure, enums and APIs

~

CODE

Usecase
< € ares

[ user_application (main.c) } USER

CLOCK_XMC1 APP
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Where to download DAVE™ Example Projects?

1. Example Project library within DAVE™
2. DAVE™ website
3. Example from XMC Lib package
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How to load Example Project in DAVE™? (1/4)

» Example Project library within

DAVE™

1. Help - Install DAVE

APP/Example/Device Library

Welcome

(7)  Help Contents
4" Search

Dynamic Help

Key Assist...

Tips and Tricks...
DAVE™ Forum
DAVE™ News

Send Feedback Mail
Cheat Sheets...

Ctrl+Shift+L

g2y Install DAVE APP/Example/Device Library...

Check for DAVE APP Updates
Uninstall DAVE APP/Exarmple/Device Library...

2. Select DAVE Project Library

Manager

% Library Manager Wizard =Rl ™ >
Download Libraries Page
This wizard page helps in downloading the libraries of type example projects or apps
library
Dave Site
Work with : | DAVE Project Library Manager | Add

Find more library by working with the Library Update Sites preferences

2015-05-22

(infineon.

3. Select Examples in the
Libraries window - Click Next

% Library Manager Wizard [E=SREal™ =™
Download Libraries Page
This wizard page helps in downloading the libraries of type example projects or apps
library
Dave Site
Work with: DAVE Project Library Manager - [Add..

Libraries

Enter the keywords to filter :

Name

Find more library by working with the Library Updste Sites preferences

4[] XMC1000
a [7] XMC1300 Series

7] Timed-Input-Output
7] System Control
» [¥] Memaory
4 [7] XMC1200 Series

4 [/] DAVE v4 Example Projects with DAVE APPs

<
Select All | | Deselect All

@

4., Accept terms of the Iicehse
agreements >Click Finish
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How to load Example Project in DAVE™? (2/4)

y DAVE™ website 5. Select Archive File - Browse to

_ downloaded project zip file
1. Go to DAVE™ Version 4 -

We b S i te Import DAVE projects

Import Existing DAVE Projects

http://www.infineon.com/dave/v4
@) Select Archive File CHAIL_DAVEW _Project XMCI3VCOUNT [ml

2. D load DAVE™ EXAMPLES
. O W n O a V| COUNTER_EXAMPLE_XMC13(COUNTER_EXAMPLE_XMC1 Select All
DAVE™ XMC Lib (Low Level Driver for XMC MCUs) and DAVE™ APPs composed to application examples DeSelect All
3

EXAMPLES
4 m
1 Copy Projects Into Workspace
. > = e

3. In DAVE™, go to File > Import @ ——

4. Select DAVE Project > Next 6. Click Finish
% Import oo |

Select \

=

Select an import source:
type filter text

(= General

&= C/Ces
(= Git
4 (= Infineon
=L Build Settings

T DAVE Project

i DAVE Project From Local Library Store
+ = Install
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How to load Example Project in DAVE™? (3/4)

» Example from XMC Lib 3. Example code (main.c) can be
package found within XMC Lib package

4 | XMC_Peripheral_Library_v1.0.0 o

1. Go to DAVE™ Version 4 - 0 L
website -

http://www.infineon.com/dave/v4 + i o

4 . GPIO_TOGGLE
. ARM
. IAR
> i UART

2. Download XMC Lib and unzip s _
file 4. Create new “"Simple Main
XMC Lib Low level driver libraries for XMC peripherals (APls), CMSIS [ MISRA 2004 compliant including P roj e Ct " i n DAV ETM

documentation

& New DAVE Project CC_x )
System: imer/PWM: Analog- Communication: Application Examples:
mixed specific: DAVE Project
Signal: ) )
[ | Create a new C/C++ project for Infineon tool chains
= DMA u CCU4 = ACMP m CAN = BCCU = Examples
= ERU u CCUS = ADC m2C m LEDTS for all
= FCE u HRPWM = DAC = SPI = MATH periperhals Project Name:  GPIO_TOGGLE_Example
® FLASH = POSIF = UART = POSIF drivers and
= GPIO = USB u HRPWM ARM V| Use default location
u MATH = UsIC GCC, IAR.
u PAU and C:/DAVE_Workspace
u PRNG Tasking
Project Type: Tool Chain:
4 (= Infineon Projects -
a [= ARM-GCC Application

[Z] Easy Start Project

[ Simple Main Project

DAV Projed

[%] Empty Project

4 (= ARM-GCC Library -
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How to load Example Project in DAVE™? (4/4)

5. Select target device of 7. Click "2 to Build project
selected main.c example

& New DAVE Project G|

——— 8. Click % to download and run
project on target board

4 [J] Processorsinfo
4 XMC4000
XMCT4500 Series
HMCT4400 Series
XMC4200 Series
XMC4100 Series
4[] XMC1000
4 [/] XMC1100 Series
| ¥MC1100-Q040:0064

6. Delete main.c in the newly
created DAVE project

7. Copy main.c from XMC Lib
example into DAVE project

a [ GPIO_TOGGLE_Example [ Active - Debug |
+ [ Includes
- == Libraries
- = Startup

=| linker_script.ld

2015-05-22 Copyright © Infineon Technologies AG 2015. All rights reserved.



Part of your life. Part of tomorrow. (in’ﬁneon



